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List of Currently Supported Poker Rooms
Ignition Casino Poker (USA-friendly Bodog platform)
Bovada Poker (USA-friendly Bodog platform)
Bodog Poker (No USA Players)
Bodog88 (where available)
America’s Cardroom (Winning Poker Network, USA)
Black Chip Poker (Winning Poker Network, USA-friendly)
True Poker (Winning Poker Network, USA-friendly)
PokerKing (Winning Poker Network, USA-friendly)
PPPoker (Private clubs, invites from agents or club owners required)
Poker Saint (Enterra network, Evenbet poker app)
*All iPoker Sites in All Countries, Including (but not limited to):
Bet365 Poker
Titan Poker & TitanBet
Betfair Poker
William Hill Poker
Winner Poker
NetBet Poker
Paddy Power
Holland Casino Poker
Dafa Poker
EuroBet
Boyle Poker
Mansion Poker
BetnGo
BetFred
Expekt Poker
Bet365.it (iPoker room, bot reads Italian here)
Betfair.it (iPoker room, bot reads Italian here)
Titanbet.it (iPoker room, bot reads Italian here)
Eurobet.it (iPoker room, bot reads Italian here)
Sisal.it (iPoker room, bot reads Italian here)
Betclic.fr (iPoker room, bot works in English or French here)

1. Quick Start
1.1

Installation and Program Access

Unless you changed the path, the bots were installed on your c: drive in a new
folder named Poker and in further subfolders named:
history for the PLO4-Hi bot
stats for the PLO5 bot, and
hands for the PLO Hi-Lo bot.
All files associated with these bots, including profiles and user manuals, should
all be in these respective folders and can be accessed by going to your C: Drive
and following the path from there (open the Poker folder and then either the
history, stats, or the hands subfolder).
Tip: A quicker way to get to a bot’s file folder, if you allowed the desktop
shortcuts to be installed, is to right-click the icon and select Open File Location.
Please note that additional temporary files will be created and stored in the
folders once you open the bot, including the session log which is a text file titled
omaha or omhilo (and may or may not show a .log file extension). The session
logs record every play the bot made in the last session, showing exactly what the
bot saw and giving a reason for every action taken.
Any of the three bots can be started by double-clicking the program icons in the
normal manner. They do not need to be run as administrator.
Windows 7. Please use the default Aero Windows theme if running Windows 7.
Windows 8. While we prefer Windows 10 or Windows 7 for our software, the bot
will work on most Windows 8 computers as long as you have updated to
Windows 8.1. You may also like to read this thread in our support forum where
other Windows 8 users have reported on what they did to optimize it for the bot:
http://bonusbots.com/support/index.php/topic,7405.0.html
(You will need to log into our support forum first in order to access that board.
There is a lot more to our support forum than what is visible to guests –
including a profile marketplace board – so make sure you get registered there
and log in to check it all out!)
Windows 10. Windows 10 is fully supported for our bots, with all our supported
sites. No special settings are needed other than language set to English/US (or
Italian) and the Display setting set to 100%.

Errors reported by bot on start-up: When you start the bot it will check your PC
display settings and give a numbered error message if they do not match those
required by the bot. The Appendix at the end of this document tells you how to
correct each of these errors. If you get any of them, please refer to the Appendix
to correct them before proceeding further. If you are unable to rid yourself of the
error message, please contact us by email.
Verify Bot Window Data: After doing the initial poker room software settings
adjustments described in section 1.3 below, put the bot in a low stakes cash
game, playing one table only, and keep the bot window open on your screen.
Watch closely and make sure accurate information is being reported in the bot
window data. Especially pay attention to the big blind size and your stack size
figures – if those are not being reported accurately, the bot will appear to play like
a maniac but it will be because the bot thinks your stack is extremely low. If the
information scrolls too fast for you to read it, you can close the bot and verify the
data in the bot’s recorded session log afterwards.
English Language Regional Settings in Windows. Our bots need your
Windows language to be in English at most of our supported poker platforms (the
special Italian rooms supported are exceptions). From the Control Panel in
Windows, find the Language and Regional Options. Set this to English /
United States. (Please note that English / United Kingdom can cause problems
due to their using commas in place of decimals, so do not use that.)
If your native Windows language is not English and the bot does not report
the correct big blind size or stack size in the open bot window (or reports stack =
unknown) even after changing your Windows language to English/US, you may
also need to adjust your language for non-unicode programs. Here is the path
for doing that in Windows 7 (Windows 10 will be something similar):
Control Panel >
Clock Language and Region >
Change Keyboards or other input methods > set keyboard language to English here
Administrative tab >
Language for non-unicode programs > here set this to English/US

Don’t forget to make sure your keyboard language is set to English /US on the
third step on the above path.
Poker platform setup: The list of currently supported poker sites and platforms
is at the top of this manual. Each supported poker room requires some setup
steps before the bot will work there (see below). The bot may also play at
additional sites on the same network as any of our officially listed sites – if not, it
is probably an easy add for us so contact us to request it.
Do not attempt to run the bot before fixing error messages and doing the
necessary setup at the poker room you want to play at. This is critical. If you
don’t fix error messages in the bot window and/or do the required poker room

setup, the bot may not be able to read the cards, big blind, stack sizes, or the
situation properly - and as a result may appear to act erratically.
Desktop Display. The bot is sensitive to screen display and will not usually work
on unusual screens such as a television or dual monitor. Touch-screen hybrid
“convertible” laptops are also problematic and usually won’t work.
Please make sure your screen Display is set to 100%, the smaller setting, by:
Right-click on Desktop > Choose Personalize (or Display on Windows 10)
Select Display (in lower left) in Windows 7
Make sure Display is set to 100%, the smaller setting
Anti-Virus and Anti-Spyware Warnings: If you get a warning message from
your anti-virus software about our program, it is a false positive. Some security
programs don’t like the looks of our software. Rest assured our software is 100%
safe. We have been in business since 2006 and have over 14,000 members in
our support forum. Tell your Anti-virus to leave the bot folder alone and let our
script run (you may even need to disable the file shield function of your AV
program in order to run the bot).
The alternative is to disable your anti-virus program, download the bot again, and
keep it disabled while you play.
Language for Poker Room Client. Our poker bots can only read United States
English or Italian (French iPoker rooms are a possible exception) so you must be
using one of these language options on the poker room software.
If the only action the bot ever takes is folding even when the instructions in
the bot window say to raise or call, you may have a CPU configuration issue on
your PC that can be fixed by setting it to use only one core. The path for making
this adjustment is as follows:
START / All Programs / Accessories / Run >
In the Run window type in MSCONFIG and hit enter >
In the BOOT tab click on Advanced Options >
Put a tick in Number of Processors and set it to 1

Taking a Screenshot: There is a built-in Take Screenshot button on the bot.
When pressed, this function saves the current screen image, in addition to a
completed output copy of the current log, to the bot folder. The image is a special
file type which won't open on most PCs, but is reviewable by our developer. If
you wish to view the image yourself, you can download a free app called
Irfanview here:
http://www.irfanview.com/main_download_engl.htm

If you are having any kind of issues with the bot, click the Take Screenshot
button (when the problem is on screen) and email the image + log to us.

Options Settings Menu
The bots include many behavioral options the user can set. These are found on
the main bot menu by clicking on Options. Notice the choices are organized into
sub-menus.
Not all of these settings will override profile instructions, however, so be
sure to read Section 2 of this manual to gain an understanding of how profile
instructions are prioritized. Most of the time you probably want to use a text
profile, so will not mess with the option settings that affect play (as those options
would likely not ever be activated, being overwritten by the profile).
Options Settings that Always Work
The following option settings override profile instructions, so will always work.
Some of these can be important to your objectives.
Sit-out Options
This group of options allows you to tell the bot to quit playing after a certain
amount of time, certain number of hands, when your stack size grows to a certain
level, or when the number of opponents at your table shrinks to a certain number.
In the case of the opponent count, the bot will sit back in when the opponent
count grows back to the number you select here (unlike the PPL sit-out
command, which is permanent). All other sit-out commands on this menu are
permanent sit-outs, except for the bathroom break.
Bathroom Break Setting (Under Sit-out Options)
You may want the bot to take breaks in cash games, to mimic being human. You
can set the interval and the time of the break. The shortest allowed break time is
2 minutes. It is not recommended to take breaks much longer, as you are likely to
get removed from the table. A good setting for cash games is 2 minutes every
80-120 minutes. If you do not want the bot to take a bathroom break, such as
when you are playing in a tournament, simply set the interval to 900 minutes.
Max Players Allowed at Table
This option lets you manually tell the bot what table type you are on, in case it is
having trouble auto-detecting the player count. If you are sitting at a 6-max table,
for example, and notice the player count occasionally saying 7 or 8, try setting
this to 6 (and vice-versa). The bot will then know the correct opponent count by
combining this setting with the fold count when it is your turn to act.

Other Settings
Occasionally we put a “poker country switch” on this menu for certain sites to tell
the bot which poker client you are using if there are differences in the clients
between countries. You should check with us (in our forum or by email) before
setting one of these switches to see if it is currently recommended.

Rakeback & Bonuses
For Rakeback and special deposit bonus deals sign up for your poker room
accounts through this link:
https://tinyurl.com/b3jrz4

1.2

Poker Room Settings

Bodog / Ignition Casino Poker / Bovada / Bodog88
The following poker room settings adjustments are all critical and must be set
accordingly (from the lobby) in order for the bot to function properly.

1. On the Table Settings tab make sure the red background, default deck, and
the black card back are selected.
Nothing else matters on this tab, but it is good to turn off opponent chat for
botting.

2. On the Game Play Settings tab under Game Play Setting you should match
the following settings.
The most important thing here is to have Disable Pop to Front unchecked!

3. Still on the same Game Play Settings tab, but now under Seating, make sure
Do Not Use Preferred Seating is unchecked. Please note this is a different
instruction now than we gave for past versions of their poker client.
In addition, set the preferred seat for each table type as bottom-center, unless
there is no bottom center seat in which case set it as bottom-right.

4. On the Default Buy-in tab Auto-Post Blind should be enabled (although this
is not critical for bot play).

5. Finally, the first time you open a table close the sidebar window on the right
side, before starting the bot. Our bot cannot play if this is open. Please note this
entire window must now be closed, including the chat, not just the mini-games on
top.
Do this by clicking the little arrow on the right side. You should only need to close
this once, the first time you open a table.

Start the bot after you take a seat at a poker table! Simply click the start button
on the bot menu. To stop it, click the stop button.

Ignition / Bovada / Bodog Troubleshooting

* No sidebar on the poker table window -- click the arrow in the middle of the right
side to collapse it completely. Please note this has recently changed and now the
entire window must collapse, not just the mini-games on the top half.
* You must always be in the bottom center seat, and must use preferred seat
view to stay there. Double-check your Ignition/Bovada settings to make sure they
match with the ones shown in the screenshots in the Easy Start Guide PDF.
* Make sure no other software is running/open when the bot plays (including web
browsers, Teamviewer, etc), and minimize the lobby.
* If you are using a dual monitor please disable it completely and use only the
first monitor. Similarly, if using a laptop do not attempt to use an external monitor
-- use the laptop screen. Also, TV screens and "convertible" laptop-tablet hybrids
usually do not work. We recommend a single standard non-touch screen monitor
(although laptops with touch screens often work as long as they are not a
convertible tablet, especially if there is an option to disable the touch screen).
* Your screen display must be on "100%" (not 125%). Right-click on your
desktop, go to Display (or Personalize > Display on Windows 7) and make sure
this is set to "100%" or "100%, Smaller."
* Your windows language must be set to English/US and you must be using
English language in the poker room client.
* If running Windows 7 please use the default "Aero" Windows theme.
* Finally, you can try playing with your resolution setting and see if you find one
that works better.

Winning Poker Network
(America’s Cardroom, Black Chip Poker, True Poker, PokerKing)
Important: Additional stealth is now required for these sites (given at end).
1. On the Playing Experience > Gameplay tab match the following settings. It is
especially important to have and Show player avatar and Use tournament final
table graphics unchecked!

2. On the Playing Tools > Gameplay tab match the following settings. It is
especially important to have and Show chips as # of big blinds and Auto
switch between tables unchecked!

3. On the Playing Tools > Bet Sizing tab match the following settings. Note
that only one of these should be checked.

4. On the Table Design tab, the following settings are all mandatory and must
be set as shown (green felt, 2-color deck, default card backs):

5. On the Table Design > Lobby tab, match these settings (English language
and do not enable the dark lobby).

Important additional stealth measures now required for these (WPN) sites.
They started looking for our bot, and will require a ridiculous list of identity
verification steps if they detect it, and likely ban you even after you comply with
the list. Do not keep much money in your account if you bot here, and take the
following extra stealth measures:
1. Rename the “Poker” folder on your C:Drive to something else, and then
move the folder somewhere else such as inside one of your Windows folders in
your Program Files. Also rename the “data” folder inside it.
2. Delete the desktop shortcut (do not neglect this step!)
3. You now need to rename the bot file, create a new desktop shortcut to the
renamed bot file (optional), and set the new shortcut to Run as Administrator the
same way our PPpoker setup shows.
4. When you get your license, keep it inside the buried bot folder, not on your
desktop or on your C:Drive.

Start the bot after you take a seat at a poker table! Simply click the start button
on the bot menu. To stop it, click the stop button.
Rakeback: Some of the poker rooms on this network offer a 27% rakeback deal
which you can access here: https://tinyurl.com/b3jrz4

PPpoker
Please note that emulators (such as Bluestacks etc.) are not supported. You
must use a Windows PC and the Windows download of PPpoker. If you live in a
country where the Windows download page (PPpoker.net) is blocked, you can
use a free VPN to download it. We recommend Windscribe and any Europe IP
address such as France.
Required PPpoker Settings:
1. Close the initial log-in window (by clicking the X in the upper right corner)
to get to the first option settings screen. Here, select the 338 x 600 table size
and also the English language.

2. Once you are logged in, go to any poker table. From the poker table, click the
hamburger menu in the upper left to get to Table Settings. Then you need to
take care to match the settings shown below. Especially make sure that Card
Squeeze is disabled, and that Exact Betting is enabled.

3. On the Game Settings tab make sure you are using the 2-Color deck and
the green table felt (both of these are the default setting). The bot cannot see
the 4-color deck or play on a different color felt!

Beeping: When the bot encounters something that needs your attention (such as
a captcha puzzle to solve or the “rebuy chips” screen) it will make your PC beep
at you. So if you are in the area and hear the PC beeping when the bot is playing
at PPpoker, you need to scoot over to your PC and handle it to avoid being
removed from the table.
That’s it (as long as your PC Display setting is 100%).
PPpoker Troubleshooting List (updated)
If you are having trouble make sure:
• Your PC "Display Setting" is set to 100%
• PPpoker Table size is set to 338x600 (set this BEFORE you log in, click the
little X)
• PPpoker language is English
• 2-Color Deck (not 4-color) which is the default, and default green table felt
(under Game Settings, you must set that from an open table)
• Card Squeeze and Card sort are disabled (under Table Settings)
• Customized Action Buttons are DISABLED (under Table Settings)
• Exact betting is ENABLED (under Table Settings)
• Disable Game stats if the club has them
• No dual monitor, do not use a TV screen as a monitor or an external monitor on
a laptop, do not use a convertible laptop-tablet, do not use an 'all-in-one' PC.

If you still need help, contact us by email and we will come on by Anydesk to
help with your PPpoker setup.

Start the bot after you take a seat at a poker table! Simply click the start button
on the bot menu. To stop it, click the stop button.
Watch the bot after you first start it to make sure it is reporting the correct Big
Blind size and your correct stack size. If not, or if you experience any other
problems, please contact us by email or forum.
To play multiple tables see the multi-tabling instructions here.

Enterra / Evenbet Clubs (Poker Saint)
Please note that emulators (such as Bluestacks, LDplayer, etc.) are not
supported.
You must use a Windows PC and the Windows download client for these clubs
powered by Evenbet software. The bot will not work on the web-based version of
the poker club, or on the mobile version through an emulator.

1. English language is required in the poker client.
2. Match the following Table settings on the Options menu (these should all be
default except the Run it twice option):

2. Match the following Table themes on the Options menu. Please note that you
must use the 2-color deck.

3. The seat position is critical. You must be in the bottom-right seat view at
the table. It can only be set from a table, in the following manner:
A) Sit down at a table, either 6-max or 8-max, in any seat.
B) Right-click your mouse on the bottom right seat on that table.
C) Click Favorite Seat on the mouse popup menu. You only have to do this once
but you must do it for each table type (6-max and 8-max).

That’s it! (As long as your PC Display is set to 100%)
Start the bot after you take a seat at a poker table! Simply click the start button
on the bot menu. To stop it, click the stop button.
Watch the bot after you first start it to make sure it is reporting the correct Big
Blind size and your correct stack size. If not, or if you experience any other
problems, please contact us by email or forum.
To play multiple tables see the multi-tabling instructions here.

iPoker Network Including but not limited to: Bet365 / Titan &
TitanBet / Betfair / William Hill / Winner / NetBet / Paddy Power /
Boyle / BetFred / Holland Casino / Expekt / BetnGo / Betclic.fr /
Bet365.it / Titanbet.it / Snai.it / Bet365.es
Important Note: If there is a side games bar next to the poker table it must be
closed for the bot to work at all iPoker sites!
The following poker room settings adjustments are all critical.
1. On the General tab choose Classic Mode and disable as many of the other
options as you can stand. Less things showing on the table or popping up is
better for the bot.

2. On the Avatar tab disable player avatars. This is critical.

3. Set your Themes tab to use the green Classic style cards & 2-Color deck:

Scroll down on the Themes tab and select the first green felt table on the list.
For some sites this will be the Default table:

For other sites it will be the Classic table style.

4. On the Animations tab turn off all animations!

5. Set your Table tab to disable just about everything but Highlight table:

While still on the Tables tab click Configure Betting Buttons:

Important: You must configure your betting buttons as follows:

Buttons 2 and Buttons 3 must be configured for Pot and Max as shown.
Button 4 must be set to Disabled as shown.
Button 1 does not matter.

6. Set your Multi Tables tab to select all three Steal focus options only:

7. If the site offers a Player HUD tab, disable the Player HUD!
8. Close any sidebars in the poker table window! These vary by site. Only the
poker table must be in the poker table window! If there is a sidebar, there will be
a button to close it so the poker table expands to occupy the entire window.
Start the bot after you take a seat at a poker table! Simply click the start button
on the bot menu. To stop it, click the stop button.
Watch the bot after you first start it and make sure it is reporting the correct Big
Blind size and your correct stack size.

iPoker Troubleshooting
* No sidebar in the poker table window. There should only be a poker table; if
there is any kind of sidebar please find the button to click to make it vanish or
minimize to the side. This includes "mini games" and casino game ads. They
can't be there.
* Stack size must be displayed in currency, meaning real money, not by the
number of big blinds! (This is a relatively new option in the settings.)
* Green table felt (at some sites this is the "default" table style -- at others it is
"classic").
* If "Auto Center my seat" is an option (on the Table tab or elsewhere) enable
this
* Player avatars are disabled, right? These cannot be showing on the table.
* Animations are all turned off, right? See screenshot in our latest PDF setup
instructions.
* If Player HUD is an option, make sure it is disabled!
* Display DPI on your PC is set to 100% (not 125% as some PCs come set from
the factory). Right-click on an empty space on your desktop and find your Display
settings.
* Windows language set to English/US (Italian rooms are the exceptions)
* English speaking version of the poker client (Italian rooms are exceptions)
* Configured the betting buttons in the poker client properly, as shown in our PDF
screenshots, for Pot and Max
* Not using a dual monitor, right? Or an external monitor hooked to a laptop? Or
a TV screen as a monitor? (A dual monitor, if even hooked to the tower, may
need to be disconnected completely.) Please note "convertible" laptop-tablets
with a touch screen do not usually work, either. We recommend a single
standard non-touch screen monitor (although laptops with touch screens often
work as long as they are not a convertible tablet, especially if there is an option to
disable the touch screen). Update: Unfortunately, "all in one" PCs seem to be
problematic as well. We recommend a spare laptop or a traditional PC tower
hooked to a standard-size monitor.

1.3 Additional Stealth
While the Omaha Bots include a built-in Hiding feature, there are some additional
steps you can take to hide it on your system even further. We want to stress,
however, that we think this is usually unnecessary unless we give site-specific
setup instructions to do so. Poker site crackdowns on botting are rare. Your best
defense is to simply not play inhuman-looking marathon sessions.
Moving and renaming the bot folders.
A) Create a new folder on your PC somewhere, perhaps in your Windows
sytem folders, and name it something creative like “photoedits.”
B) Rename the three folders that installed on your C: drive when you
downloaded the bot. (Remember, on your C: drive there is a folder titled
Poker and within that three folders titled history, hands, and stats -rename these to something that has nothing to do with poker).
C) Move the three bot folders that you renamed in Step B above into the new
folder that you created in step A above. Then delete the (now empty)
Poker folder.
D) Move your license file into the bot folder with the bot (if you had it on your
C: drive or on your desktop)
E) Remove any desktop shortcuts to anything bot-related. No desktop
shortcut to the bot or even the bot folder! You will need to “dig” for the bot
when you want it so get familiar with the new path, probably through This
PC then C:Drive then Program Files.
F) Rename the bot itself (omahabot.exe) to something like
MSOUTLOOK.exe or skype.exe. Do not rename anything else in the bot
folder!
G) It is probably fine to create a new desktop shortcut to the renamed bot
.exe file, right-click and select Send To > Desktop (Create shortcut) but
you will then need to set that shortcut to Run as Administrator as follows:
Important: If you rename the bot file from omahabot.exe to something else,
you will then need to always open the bot to Run as administrator each time
you open it. This can be done from the mouse right-click menu on the
program icon, or you can set the properties so it always opens that way.

1.4 Sitting in a Game and Starting the Bot
To open the bot double-click on the program icon titled omahabot, omaha5bot,
or omaha-hilobot (they may show the .exe file extension after the name as well).
If running Vista, you must run the bot “as administrator.” Do this by right-clicking
on the icon and choosing Run as Administrator from the mouse menu.
The default playing profile loads automatically, and you should get that
confirmation message in the bot window when you first start it. To use a different
profile, click on Omaha (or Omaha5 or OmHi-Lo) and then Read profile on the
bot’s menu. A window will open showing the available profiles we included with
the bot download, which are simply the latest cash and tournament profiles
developed by a collaborated effort in our forum – which, by the way, you are
invited to participate in. Simply click on one of them and then select Open.
» Open the poker room software. Make sure you set it per section 1.3, above.
Find a game and take a seat.
» Click on Auto-post blinds at the poker table. You may wish to wait for the big
blind, but if you want to come in with a late position blind that is fine.
» Wait until you are clearly between hands before starting the bot (or before
opening a second bot window, see section 1.6 below for multi-tabling
instructions).
» Start the bot by clicking Start on the bot menu. You should then notice it
reading the board cards as they are dealt. When it is your turn to act, the bot will
instantly read your hole cards, position, number of opponents, stack sizes, and
the entire situation before playing the hand for you according to your profile
instructions – all within 2.5 seconds.
» Optional: Hide the bot window by clicking on Hide on the bot program menu.
Before it vanishes from sight, it will give you the keyboard command for bringing
it back (usually Alt+F11 ).
» Stop the bot by clicking Stop on the bot menu, or by setting one of the
features on the bot that will stop it automatically by time, number of opponents, or
what happens to your stack size.

1.5 Multi-Tabling
To play additional tables, first take a seat at your first new table and click autopost blinds.
Then, on the open bot window, go to Omaha > New Window and go ahead and
click on New Window. A second bot window will appear. Voila!
Choose a profile for the new bot window with the Read Profile function. This will
not affect the profiles in use at any other open bot windows! Each bot window
operates independently. So you can have the bot play an SNG with one profile at
the same time it plays a cash game with a different profile.
Only one unhooked table can be open when you start the bot. It will
automatically attach itself to whatever table is open that has no other bot window
connected to it. There cannot be two poker tables open that do not have bot
windows attached to them, or it won’t know which one to hook to. For this reason,
you must open the tables, join them, and hook a bot window to them (by pressing
Start on a bot window) one at a time. Multiple bot windows can be opened in
advance, however.
The Hide button hides all the bot windows at once. So, when multi-tabling,
minimize the bot windows that are already attached first, and when you have
started as many tables as you want, then hide all the bot windows at once.
Table Positioning Tip: You should generally try to position the tables so there is
minimum overlap between them, as a best practice, before starting the next bot
window. On smaller screens, at least position them so the betting fields and
buttons do not overlap. That said, tables do not need to be visible for the bot to
work, and they can all completely overlap if necessary.
If the bot cannot connect to the additional table on its own, it will ask you for the
name of the new table. Be sure to spell it correctly and make sure you capitalize
the right letters. Try to do this as quickly as possible.
Repeat the process for opening a third and fourth table if desired, to a maximum
of 6 tables.
To stop: First quit the poker tables in the normal manner, before closing the
poker room software. If the bot windows are hidden, bring them all back at once
with the appropriate Alt+F command. Close the bot windows individually.

-------------- Quick Start End --------------

2. Profiles
2.1 Using Different Profiles
Many alternative profiles targeting different game environments already exist for
our poker bots. We include several good ones with the bot download. Others can
be discovered in our support forum, or created by the user.
You can make the bot play any way you want for any poker situation. There is a
short learning curve for doing this, but it is not difficult.
The bot gets it’s playing instructions from one of four overriding “levels,” the top
level which you can alter and customize to your heart’s content. User instructions
for specific situations can be created and saved on a standard text file by using
Notepad, the text editor that comes with Windows. These saved playing
instructions are referred to as profiles. You don’t need any computer
programming knowledge in order to make your own profile, or to tweak an
existing profile to your liking. Just knowing basic poker terms is enough for most
people to be able to do this, especially with our help and guidance in the forum.
There are two types of profile formats:
.ppl (a type of binary file)
.txt (text files, which is what Notepad files are).
A .ppl file started out as a .txt profile but was converted to the other format to
protect the profile from being copied. You cannot open a .ppl file for viewing; only
our software can access it. You can create and save profiles in .txt format, but
you cannot convert them into .ppl unless you have us do it for you, or purchase
the .ppl converter from us. (You don’t need to do this unless you plan on selling
or sharing your profile and want to copyright-protect it.)
The default profile that came with the bot is in .ppl format (and has been named
omaha.ppl (or similar) so it auto-loads, as will be explained below). The only
other way you are likely to get that type of profile is if you decide to purchase one
from a reputable seller in the Marketplace section of our support forum. Most of
the free profiles in our forum, many of which are quite good, are text files that can
be opened, viewed, and tweaked to your liking.

At any given time exactly one .ppl profile and one .txt profile can be loaded
into the bot. No more. Either can be swapped out at will. Text file instructions
are the top level and override everything. Commands from a .txt profile will,
therefore, always be executed first, as that type of profile is read by the bot first.
The first matching command the bot finds is always executed. So .txt profile
actions override any conflicting .ppl profile actions. This way it is easy for
you to tweak a play here and there and save it as a short text profile.
Both types of profiles can be set to auto-load by default whenever you open a bot
window. That is what the default profile that comes with the bot is set to do. To
designate a text profile as a default auto-load profile, all you have to do is
rename it as follows:
AutoProfileOmaha for PLO4
AutoProfileOmaha5 for PLO5
AutoProfileOmHiLo for the Hi-Lo Bot
Any profile kept in the same folder as the bot that has the above name(s) will
auto-load into the bot by default whenever you open a bot window. So you
cannot have more than one of each file type with the above names, or it will
create a conflict. If you have one of each profile types saved with the above
names they will both auto-load. But remember, the .txt file instructions take
precedence.
For the demo we recommend you use one of the profiles included in the
download. If you are the tinkering type, you might decide to read a little of the
PPL Guide and try tweaking an action or two during your 200 free hands, to get
the feel of how customizing the bot’s actions works.

2.2

Creating (or Tweaking) Your Own Profile

In order to customize the bot’s playing instructions, you first need to understand
how the existing programming works. There are four levels in the bot where
playing instructions come from, and each higher level overrides the next lower
level. They are:
1.
2.
3.
4.

Root-level programming (lowest level)
Option Settings on the Bot Menu
Any .ppl profile that is loaded
Any .txt profile that is loaded (highest level)

The option settings on the bot’s main menu are the second level. These were
originally developed to start allowing user control of the bot’s actions. They are
explained individually further in this manual. The thing to understand about these
is that adjusting the option settings on the bot will only affect actions that are
referred to the original root level programming. If you want to create a profile just

from the bot’s option menu settings, you can still do that. But you will need to
disable all other profiles from loading (because the instructions in them will
override the option settings, so you need to rename or remove the default
omaha.ppl profile that is set to auto-load in the bot folder). This is still a viable
way to make your own profile, however, especially for tournaments.
Profiles that consist solely of option menu settings can be manually saved as a
text profile directly from the bot, and loaded again by using the menu items:
Omaha > Write Profile
Omaha > Read Profile
Write Profile is used to save them and Read Profile is used to load them. Profiles
are saved as a simple text file, and then can be edited in Notepad. You can also
add your own custom instructions to any saved profile (or any existing text
profile) by writing them in PPL underneath the saved option settings. PPL is the
easy Poker Programming Language any poker player can learn in about an hour
with no coding background needed – see the PPL Guide that came with the bot
download.
The default path for saving and loading the profiles into the bot is the same folder
where the rest of your bot program files are located.
Profiles in .ppl format are the third level that the bot gets it’s instructions from.
Remember, these are just a saved text profile that has been converted into this
format. You don’t need to be concerned about this (other than the fact that the
default profile which comes with the bot is in this format) unless you are
downloading profiles in this format from our support forum.
Profiles in .txt format are the fourth level, and top level. Instructions from text
profiles override everything. That way you can load a text profile with just a few
lines of PPL code which will tweak a few actions here and there from the .ppl
profile that you have loaded. (This is exactly what the four text profiles that came
in the bot download do, as they simply tweak the default playing profile which
auto- loads in .ppl format.) Tweaking actions from the default profile in this
manner is a great way to start making your own profile!
Within a saved profile there can be both saved option settings and PPL coding.
The PPL coding starts with the word “custom.” Some text profiles in our forum do
not bother with the bot’s option settings. These will always start with the word
custom on one line at the top of the profile. Profiles with saved option settings, by
contrast, will have those settings saved above the word custom, like this:

PPL coding always overrides the saved options settings. So PPL code in a text
profile is always at the top level and that is the best way to start tweaking your
own profile. This can be very simple, something like:
preflop
when (hand = AA or hand = KK) and raises >= 1 raisepot force
...which tells your bot to raise the pot with pocket aces or pocket kings whenever
somebody else raises. All of PPL language is simple and intuitive like this, so do
give the PPL Guide a read to start learning how to customize your own actions.

There is an “MTT tweak” of the default profile include with each Omaha bot
download. They have the term MTT in the name so should be easy to identify.
What these versions essentially do is manage your stack in tournaments, not
letting it get to short before choosing a hand to get all-in with and not gambling
much when your stack is very high.
Some profiles are simply tweaks of other profiles, while others are complete and
self-contained. It is difficult to define every possible poker situation (it took us two
years to do that). Therefore most profiles, even fairly detailed ones, still use the
original root level programming as a safety net. Many simply tweak the default
profile.
To summarize, there are three practical methods of customizing profiles for use
in different game types.
1. Make changes to the quick-settings located on the Option Menu of the bot.
Many decent profiles have been created with this method, and in fact at least one
tournament profile used by our forum members is of this type and contains no
PPL- coding whatsoever. It has made plenty of high-money finishes in large-field
MTT’s including some firsts, completely unassisted. Just remember that option
settings do not override PPL commands. So if you are making these option
setting adjustments when you have a profile loaded that uses PPL code, the
settings may not take effect in every situation you want them to.
2. Add some custom code to your saved profile by learning PPL, the easy Poker
Programming Language that puts you in total control. All of the bot’s actions can
be 100% user-configured in this manner, and it’s easy to use. If you are tweaking
a profile that uses PPL, this is the only reliable way to get your desired actions to
always occur. See the PPL Guide that was included with your download for more
information.
3. Simply use an existing profile that someone else created. There are several
good ones included in your download, and new ones can be found in our forum.

2.3

Changing Profiles

Profiles can be loaded into the bot either automatically or manually. But before
you can load a profile, you first must save it and place it in the bot directory. This
can be a tad tricky if you have never worked with a text editor like Notepad
before, so let’s make sure you are saving the profile properly.

Notepad vs. Enhanced Text Editors
If you plan on tweaking your own profile using PPL, we highly recommend
downloading Notepad 2, an enhanced text editor greatly superior to the original
Notepad program that comes in Windows. This is an open-source (free) program,
so just Google it.
One of the nice things about Notepad 2 is it displays the codelines on the left
side, so you don’t have to search for them (also, original Notepad will sometimes
misreference codelines). You can see the difference here:

Notepad 2 is on the right above. It has many advanced features, and displays the
codelines in red on the left side.

There is a critical difference between these two programs, which you need to be
aware of, when it comes to saving profiles. Original Notepad will automatically
assign an invisible .txt extension to the file type when saving a text profile. This
means you must not add a .txt extension to the file name when saving it from
Notepad! If you do, the bot will not find it when you try to load it because it will
actually have two .txt extensions, though only one is visible. (If you’ve done this,
you can fix it by right-clicking the file, choosing Rename, and then removing the
last .txt extension).
So when saving a profile from original Notepad, just name the file, without a .txt
extension, like this:

Notepad 2, however, does not automatically add the .txt extension when saving
the file. So if you are using Notepad 2, you need to include it when naming the
file, like this:

Automatically Loading Profiles
To designate a text profile as a default auto-load profile, all you have to do is
rename it as follows:
.txt file auto-load: AutoProfileOmaha (or AutoProfileOmahaHi for the
Omaha Hi Bot)

Manually Loading Profiles
To manually load a profile: On the bot menu first click on Omaha (or OmahaHiLo) and then on Read Profile.

A window will open showing the available profile modifications we included in
the download. For the demo, we suggest you select the text file named cash if
you want a cash game profile, or the file named MTT if you want a smart
tournament profile. Then select Open at the bottom of the window to load it in the
bot.

Your profile is now loaded as you can verify from the confirmation message in
the bot that the profile was read.

Whichever way you load your profile, remember it must first be located in the bot
directory with the bot (which should be at C:Poker\data if you didn’t move it).

Copying and Saving Profiles Using Notepad
This is the procedure for copying a profile from our forum and properly saving it
(using Notepad) in the bot folder for use.
1. Open the profile. Copy the code. Make sure you get all of it! A good way to do
this is by first right-clicking on the profile and then clicking on Select All before
clicking on Copy
1. Paste into a blank Notepad (Start > All Programs > Accessories > Notepad)
You can right-click the mouse now and choose Paste
2. Save As 'whatever' and move into your bot folder (inside C:Poker\data if you
did not move the location)

4. Load in the bot by going to Omaha > Read Profile and browsing for it
Alternative to Step 4:
A) Save the text file as AutoProfileOmaha or AutoProfileOmHiLo and it will
load automatically as the default profile every time you open a bot window
Do not add a .txt extension to the profile name when saving it from original
Notepad that comes in Windows! Do add the .txt extension, however, if saving it
from Notepad 2.

Confirmation of Profile Loading
The bot will give you a message in the bot window confirming the profile was
“read” if it was loaded successfully. If not, it will give you a message explaining
why it was rejected (usually because the bot cannot find the profile, or there was
a PPL typo in the profile). Please look for the confirmation or rejection message
each time you load a profile, regardless of which method you use to load it.
If you get a message in the bot window that the profile was read, then it
stays loaded! This doesn’t mean all the messages in the bot window will now
come from the profile that is loaded, however. Please note the default .ppl profile
and/or original root level programming are both still in the background, and will
still give messages saying what they would do in many situations before the toplevel profile is even consulted for the situation. Pay attention to the actions taken
in the bot messages. When you see a user defined condition being executed,
referencing a codeline, that action is from the text profile that is loaded. Also,
many profiles still do defer some actions to the default profile, and even to the
root level programming (which is affected by option menu settings).

Auto-changing a Profile Mid-session
You can have the bot automatically switch to a different saved profile in the
middle of a session. This can be triggered when the table gets short-handed,
when a specified number of hands are played in the current session, when a
specified number of minutes are played in the current session, or when your
stack size falls below a certain level. To set this up go to:
Omaha (or OmHi-Lo): Auto Read Profile
...and enter the profile file name, and choose which condition you want for
changing to that profile. The bot will give a confirmation message if you do this
correctly. If you don’t get the confirmation message, you probably need to include
the .txt extension in the profile name in the auto-read field.

3. Detailed Instructions
for Omaha Bots
Thank you for taking the time to look at our program! We hope you enjoy it, and
that you decide to use it to increase your earnings from online poker.

3.1 Run Bot as Administrator (Vista only)
This is largely outdated. The only exception is if you are using Vista for some odd
reason, in which case you need to run the bot As Administrator. Right click on the
bot icon and select the Run as Administrator to open the bot, each time. It is no
longer necessary to run poker room software as administrator, on any system.

3.2 Seat Position
At poker rooms which sit you in the bottom center position by default, you must
remain in this seat position and not change even if the poker room allows you to
change the display so that you appear in a different seat. But please also refer to
the individual poker room instructions in this manual for proper seating
configuration for each site.

3.3 Free Trial Notes
Your free demo is good for 200 hands and is mandatory prior to license
purchase. You don't have to exhaust the full 200 hands, but you do have to run it
for a bit. Use the trial to get the bot working properly on the site you plan on using
it at, and play with some of the features.

After you have run the bot, it will establish a Computer ID number, which can be
obtained on the bot menu item Omaha (or OmHi-Lo) > Get Computer ID. If you
exhaust the 200 free hands, this number will also appear in the last playing

session log file that the bot records. We will need this Computer ID number when
you purchase your license.

3.4 Where to Put the Program
The installation program places a shortcut to the bot on your desktop by default.
The files are actually installed in subfolders at C:\Poker (unless you specified a
different path). You can access the individual bot folders quickly by right-clicking
on the desktop shortcut and selecting Open File Location.
Please do not move the bot, or any of the profiles or program files, from the bot
folder. They all need to be kept in the same directory. If you want to move the
folder and/or rename it that is fine, but keep all the files together in it.

3.5 Session Log
The bot records a log of every hand played. This is a text file that is automatically
created and saved in the folder with all the other bot program files. The session
log is simply named omaha, or omhi-lo and may or may not include a .log file
extension. Each time you open the bot, the previous session is erased from the
log and overwritten with the new session.
When you use the multi-table function, multiple session logs are created, one for
each table or tournament being played. These have the same file name but are
numbered, with 2 corresponding to the second bot window you opened, etc.
They are overwritten just like the 1-table log the next time you have two or three
tables going.

3.6 Which Games to Play
The bot supports all game types including heads-up tables, single table SNG’s,
and all forms of multi-table tournaments (MTT’s). In MTT’s the bot will follow the
table changes for you as long as you don’t have an unhooked table open at the
time of the table change, or experience interference issues from other programs
or web browsers open. It is not recommended to multi-table while using the bot in
an MTT unless you are around to check on your tables frequently, due to the
higher chance of not following a table change if two occur at the same time
High stakes cash games and 1-table SNG’s are difficult to beat with or without a
bot. Most poker-botters stick to lower stakes when it comes to cash games and
1-table SNG’s. If you want to bot higher stakes, MTT’s are the way to do it - as
strategy is not very different in a high stakes MTT than at a low stakes one.

3.7 Hiding the Bot
The second to last item across on the main bot menu is Hide. This causes all
open bot windows to vanish from your computer screen completely, but they will
keep playing for you while invisible. While in hide mode the bot not visible to
screen scraping programs, and will not show as an application running on your
system either.
Before the bot hides itself, it will check your system for the availability of the last
six F-command keys on your keyboard to use for calling it back. For most users it
will start at F11, but if you have another program which uses F11 it will move on
to F11 -- and if that is also unavailable, it will finally try using F12. The order after
that is F7, F8, and F9. Before the bot windows vanish a small popup window will
appear telling you which key command to use in calling them back, and you must
acknowledge this by clicking OK before the bot will hide.
To call it back, you must hold down the ALT key on your keyboard while pressing
the F11, F12, F7, F8, or F9 key (whichever one the program told you to use
before hiding).
When multi-tabling, it is probably easiest to minimize the connected bot windows.
After all the tables you want to play are connected, you can then use the Hide
function to hide them all.
Tip: Most of us don’t bother to hide the bot these days. If a poker site really
wants to hunt for it, we can’t stop them. Sites don’t bother scraping for bots any
more, either. The only site we ever have an occasional issue with is 888, and that
is likely from other players turning in suspected bots by behavior observation.
Please note that if you forget to call the bot back from hiding after a session, the
hidden window will come back up when you try to start the bot again.

3.8 Game Type Menu
You will notice a menu item for the Game Type on the main bot menu, which can
be used to tell the bot the limit-type of the game it is playing. You should leave
this on Auto-detect unless the bot has a problem determining the limit-type.

3.9 Options Menu
The bot includes many playing options that you, the user, can set. These are
found on the main bot menu by clicking on Options. You will notice the choices
are organized into logical sub-menus. Not all of these settings will override profile
instructions, however, so be sure to read Section 2 of this manual so you
understand how profile instructions work.

Options Settings Which Always Work
The following option settings override profile instructions, so will always work.
Sit-out Options
This group of options allow you to tell the bot to quit playing after a certain
amount of time, certain number of hands, when your stack size grows to a certain
level, or when the number of opponents at your table shrinks to a certain number.
In the case of the opponent count, the bot will sit back in when the opponent
count grows back to the number you select here (unlike the PPL sit-out
command, which is permanent). All other sit-out commands on this menu are
permanent sit-outs, except for the bathroom break.
Bathroom Break Setting (Under Sit-out Options)
You should set the bot to take breaks in cash games. The purpose is to mimic
being human. You can set the interval and the time of the break. The shortest
allowed break time is 2 minutes. It is not recommended to take breaks longer
than 4 minutes as you are likely to get removed from the table. A good setting for
cash games is 3 minutes every 40-120 minutes.
If you do not want the bot to take a bathroom break, such as when you are
playing in a tournament, simply set the interval to 900 minutes.
Max Players Allowed at Table
This option only exists to let you manually tell the bot what table type you are on,
in case it is having trouble auto-detecting the player count. If you are sitting at a
6-max table, for example, and notice the player count occasionally saying 7 or 8,
try setting this to 6. The bot will then know the correct opponent count by
combining this setting with the fold count when it is your turn to act.
Other Settings
Occasionally we put a “poker country switch” on this menu to tell the bot which
poker client you are using if there are differences in them between countries. You
should check with us in our forum or by email before setting one of these to see if
it is currently needed.

Options Settings Which Do Not Always Work (because they are overridden by
profile instructions, see Section 2 )
Stack Size Recognition Note
Our poker bots read their stack size and incorporate that into several of the
option settings. This is useful for playing a more aggressive game with a short

stack (especially in tournaments) and calling raises after your bet pot-commits
you.
Stack size is set by the number of big blinds on the option menu. You will
notice that it is read from the screen in dollar amounts, however, and recorded
that way in the session log. Don't be concerned about this - the bot makes the
appropriate conversion in its calculations.
Total Investment Note
The bots keeps track of how much it has invested in any given hand. There is at
least one option where you can adjust a setting by the bot's total investment. This
is useful for making sure the bot never folds when you are pot-committed.

POST-FLOP DEFAULT BET SIZES (Aggressive Play Settings)
This setting allows you to enter a % number (which corresponds to % of existing
potsize) for changing the bot’s standard bet and raise size on the Flop, Turn, and
River. For example you might tell it to bet 100% on the flop (that is a pot-sized
bet), 75% of the pot on the Turn, and 60% of the pot on the River.
When a custom bet size other than 100% is chosen the bot will actually type in
the bet size and click Bet. When 100% is chosen it will use the pot button to bet
or raise the pot.
When 0 is chosen the bot will use it’s default programming, which is to bet the
pot on the Flop and if a half-pot button is available use that on the Turn and
River, otherwise bet the pot and the Turn and River as well. The default settings
for this option are 100 on the flop and 0 on the Turn and River so you should
adjust them to your liking if you don’t want pot-sized post-flop bets.

FOLD OR GO ALL IN OPTIONS (Aggressive Play Settings)
On the option menu you will find two Fold or Go All-In settings, for NL and PL
type games. These can be set to ALWAYS, invoked by number of opponents, or
by number of hands played in the session. When either of these settings are
triggered the bot will still check and fold as normal, but when it's action is to call
or raise it will attempt to go all-in. (This includes all programmed blind-stealing
and bluffing situations.)
Please make sure both of these options are set on default in game environments
where you do not want the bot to push all-in. Setting them on default turns them
off so the bot will play as normal.
The difference in the two settings is how they are triggered.

FOLD OR GO ALL IN WHEN OPPONENTS (AFTER FOLDS) LESS THAN...
This setting is triggered by the remaining opponents in any particular hand. That
could happen any time regardless of how many players are sitting at the table, as
long as the set number of hands have elapsed in the session. Note that the bot
might start raising attempting to get all-in on the first hand dealt using this option
if you don't apply it after a set number of hands.
You can also choose to have this setting invoked only when your stack size falls
below a certain level. However please note that the active number of players in
the hand must still be below your chosen number for this setting to trigger, even
when your stack is small.
FOLD OR GO ALL IN WHEN OPPONENTS AT TABLE LESS THAN...
This setting is only triggered by the original number of opponents sitting at the
table. So if you have it set to less than 4, as soon as the number of opponents
are 3 or less the bot will always start raising to try and get all-in when it plays.
This is a good choice for finishing SitnGo's and Tournaments.
You can also choose to have this setting invoked only when your stack size falls
below a certain level. However please note that the number of players sitting at
the table must still be below your chosen number for this setting to trigger, even
when your stack is small.
**PLEASE NEVER SET BOTH OF THE FOLD OR GO ALL IN OPTIONS TO
TRIGGER. CHOOSE ONE OF THEM IF YOU ARE GOING TO USE THIS
FEATURE, OR BETTER YET USE THE AGGRESSIVE TOURNAMENT
SETTING INSTEAD**

ALWAYS CALL WHEN OPPONENTS RAISE IS BELOW (Aggressive Play)
This setting applies only to NL and PL games. It's purpose is to keep the bot from
folding to small raises by your opponent when it would be foolish from a pot odds
standpoint to do so.
There are two parts to it: One for measuring the opponent's raise against your
bet size, and one for measuring the bot's total investment in the hand.
There are three positions available for measuring the opponent's raise size:
20%, 30%, and 40%. Most players prefer the 40% option in most game
environments. So that means whenever you bet and somebody raises but the
raise is less than 40% of the amount you bet the bot will automatically call. (If you
are playing high-stakes cash games you might prefer a lower setting for the bet
size portion.)

These settings also apply to an opponent attempting to sandbag you by calling
your bet when they only have a few chips left and then betting their last few chips
out on the next round. The bot will remember that it was the last bettor or raiser
on the previous betting round in this case and apply the same settings you have
chosen.
The second part is a setting for always calling when your current stack size is
below a certain percentage of your total investment in the hand. The default
setting is quite low and we recommend setting it much higher - probably at least
75% - especially for tournaments.
The two settings in this window protect you against folding when you have
invested so much in the hand that folding would be undesirable. So if you bet say
$1200 in chips in a tournament and somebody with only $1400 chips raises all-in
the bot will call. Or if somebody raises large and you only have $200 left in chips
after making that same $1200 bet the bot will call. Or if you bet $1200 and get a
call from a player who only has $200 in chips left after he calls and he acts first
on the next betting round and bets his last $200 out the bot will also call,
regardless of what card hit the board.

MINIMUM BET OVERRIDE (Aggressive Play Settings)
This affects post-flop play in No Limit and Pot Limit games only. This option lets
you decide how you want to deal with knuckleheads who make a minimum bet of
only 1 big blind. Please note that the selected action will only take place if the pot
size is at least 5 big blinds and your hand value is best high-card or better.

AGGRESSIVE TOURNAMENT SETTING (Aggressive Play Settings)
You will notice a setting towards the bottom of the option menu titled Aggressive
Tournament Setting. When you click this a check mark appears next to it and
when you turn it off the check mark vanishes. The check mark tells you that this
setting is turned on.
When this setting is on the bot plays more aggressively with certain hands (such
as nut low or top two pair / sets on non-threatening boards in Hi-Lo split games,
or two pair including top pair on non-threatening boards in PLO Hi). This allows
you to raise and get your chips in with any kind of decent hand, which is often
desirable in tournament situations. The bot will also ignore post-flop bet sizes
when this option is checked, which means you won't get bet off decent hand
when short-stacked.
It is highly recommended to use this setting whenever playing in any type of
tournament, even 1-table SNG's.

FOLD NON NUT HANDS POST FLOP WHEN BET SIZE IS MORE THAN
(Tighter Play Settings, Omaha/8 Bot Only)

This setting is for PL and NL games when playing Hi-Lo split. When the
Aggressive Tournament Setting is turned on this function is ignored. In cash
games it is undesirable to call very large bets post-flop with non-nut holdings (the
best possible hand in one direction or the other). You can set that level here,
measured by the big blind size.
The default setting is 25 big blinds, which is a good setting for higher stakes cash
games. In the smaller games it might be a good idea to raise that level.
Please note that some non-nut high hands in certain situations are still
considered nut holdings by the bot for calling purposes. This includes an acehigh flush when only one straight flush is possible, and the best 2 or 3 possible
full houses when a pair is on board (depending on the situation, as 4 of a kind is
technically the nuts).

3.10 Saving Profiles
Once you go through and choose all the options you want, above, for a certain
game environment, you can save them as a profile. That way you can get them
all back quickly without having to set them all again.
To save a profile, click on the first item on the main menu Omaha (or OmHiLo)
and then on Write Profile
A window will appear with the default name "omaha_profile.txt"
If you only want to save one profile you may as well call it that, as this is the
default profile name for both saving and loading profiles. However most players
will want to save at least several profiles, in which case you need to rename
them.
For example, c for cash games (save as ‘c’ load as ‘c.txt’), or s for 1-table SNG's,
m1 for the beginning of tournaments, and m2 for when you notice you are shortstacked in a tournament.
To load a saved profile, go to Omaha (or OmHiLo): Read Profile...
...then browse to the profile you want to load, select it, and click Open.
Please note that profiles saved by the bot are saved by default in the same
folder/directory where the bot program is kept. This makes loading them easy as
the bot looks for them in that location. Alternatively, you could save them

somewhere else by specifying the path - but of course you will need to specify
the path to load it as well. For example: C:\cash6max.txt.

3.11 Switching Profiles Mid-Session
You can have the bot automatically switch to a different saved profile when the
table gets short-handed, when a specified number of hands are played in the
current session, when a specified number of minutes are played in the current
session, or when your stack size falls below a certain level. To set this up go to:
Omaha (or OmHiLo): Auto Read Profile
...and enter the profile file name and choose which condition you want for
changing to that profile.

3.12 Custom Coding Profiles With PPL
Our poker bots support user custom profile programming, in addition to the
settings on the option menu, for those wanting more control of play. This feature
will allow you to completely program all of the bot's decisions yourself. The
process is easy to learn and it has resulted in the creation of a marketplace
where users of our poker bots trade their custom profiles with each other. If you
are interested in this please read the PPL User Guide, a pdf file that you should
have received with the bot download and, therefore, can be found in the bot
directory with all the other bot files on your PC.

3.13 Setting Your Own Default Profile
There is an additional feature that will allow you to have a certain profile be the
default profile that every bot window will use without having to load a profile at all.
All you need to do is save whichever profile you want for the default profile as:
AutoProfileOmaha.txt
AutoProfileOmHiLo.txt
…in the same folder as the bot. When a text file titled thus is detected in the bot
folder, it will load automatically into every bot window you open. You would then
need to load a different profile only for the tables that you want to use a different
profile at.

3.14 Multi-Tabling
You can currently bot up to six tables at a time on all our supported poker
rooms (any exceptions are set by the poker site, not by us). Even with small
monitors and overlapping tables, you shouldn't have any trouble.
Table Positioning Tip: You should generally try to position the tables so there is
minimum overlap between them, as a best practice, before starting the next bot
window. On smaller screens, at least position them so the betting fields and
buttons do not overlap. That said, tables do not need to be visible for the bot to
work, and they can all completely overlap if necessary. Do keep some space
between the edges of the tables and the edge of your screen.
If the bot cannot connect to the additional table on its own, it will ask you for the
name of the new table. Be sure to spell it correctly and make sure you capitalize
the right letters. Try to do this as quickly as possible.
Repeat the process for opening a third and fourth table if desired, to a maximum
of 6 tables. How many tables you can play before suffering a performance lapse
depends somewhat on the poker room, your monitor size, and the configuration
of your PC system. Most people can play at least three or four tables.
Multi-tabling is accomplished by opening multiple bot windows and hooking them
to each table, one table at a time. Here is the procedure:
Get into the first table as normal and start the bot, but don't hide it yet. Instead,
get into a second table and separate it as much as possible from the first table on
your screen (without moving any part of it beyond the edge of your monitor).
Then, on the bot's main menu go to:
Omaha (or OmHiLo) > New Window
This opens an additional bot window which operates independently. You can now
minimize the first bot window if you like. When you press start on the second bot
window it should connect to the new table -- on occasion, it may ask you for the
table (or tournament) name. This is case sensitive. It will then connect and you
can repeat this process for additional tables if you like. After connecting to as
many tables as you like, if you wish to hide the bots click Hide on any of the bot
windows and they will all go into hiding.
Each window operates independently so you can play different game types with
different profiles loaded in each window. You cannot, however, multi-table
between poker rooms. All your tables need to be at the same room.
Please note that the bot handles table changes in MTT's automatically at all the
poker rooms and does not need you to be there to enter the new table number as
you do when opening a new bot window for multi-tabling. That said, we do not
recommend multi-tabling MTT’s with the bot unless you are going to be able to

semi-monitor the computer. This is because if you have a table change at more
than one event at the same time, both bot windows may stay disconnected as
you will then have multiple unconnected tables open.

3.15 Waiting for a Table
The bot has a function to wait for a table to appear before starting to play. This
option will appear if you click Start on the bot and it cannot find a poker table
window to hook itself to. It is useful for registering for tournaments and SNG’s
early, before they start, so you can set the bot to play in them and just walk
away.
Please note that the tournament must be a type where you are seated
automatically, that is the table appears with you in your seat already when it
starts. At some tournaments on some sites we must wait and click on a popup
window to take our seat, so this feature will not work at those. How well this
feature works depends on which poker room you are playing at, which type of
tournament you are playing, and your individual PC setup. So please experiment
with it before trusting it to start playing for you.
Please Note: You cannot wait for multiple tables and therefore should use this
feature only to play one table at a time. Please do not attempt to play multiple
tournaments using this feature.

4. Running the Program
See Section 1: Quick Start for complete instructions on setting up and using the
Omaha Bots, including the necessary Poker Room settings.
Performance Tip: Don't check email or do other stuff while the bot is running.
Have all your browser windows closed. Especially don't have a browser window
open at any kind of poker site as the bot can get confused
Stealth Tip: Don't run the bot for more than 12 hours at a time. This could flag
your account to other players and/or the poker room as a possible bot.

5. Miscellaneous
Taking a Screenshot: There is a built-in Take Screenshot button on the bot.
When pressed, this function saves the current screen image, in addition to a
completed output copy of the current log, to the bot folder. The image is a special
file type which won't open on most PCs, but is reviewable by our developer. If
you wish to view the image yourself, you can download a free app called
Irfanview here:
http://www.irfanview.com/main_download_engl.htm
If you are having any kind of issues with the bot, click the Take Screenshot
button (when the problem is on screen) and email the image + log to us.

Rakeback and/or bonus clearing is usually necessary to show a worthwhile
long-term profit in cash games. If you don't have a bonus or rakeback going for
you, you should probably only bot tournaments.
You can get rakeback through our favorite provider here: http://tinyurl.com/b3jrz4

Appendix
Error Codes and How to
Fix Them
Please note the bot is unlikely these days to ever display any of these error
codes on most modern Windows 7/8/10 systems, especially if you have followed
the Quick Start setup instructions properly.

Error Code No 1: Version is not compatible
This error is given after Bodog upgrades their software. Such upgrades
temporarily break the bot. We normally post a new updated version of the bot
which fixes this problem within a few days of the upgrade. Bot upgrades can be
downloaded for free from our download page.

Error Code No 2: You must run the bot as administrator
This is a Vista specific error. If you see this, it means that you are not running the
bot as administrator. To fix, close the bot and restart it by right-clicking on its icon
and choosing “Run As Administrator.”

Error No 3: You must set style to Classic (Vista & Windows 7)
This error should occur on Vista and Windows 7 machines only. If you get this
error code in conjunction with one of the other errors below, then fix the other
error first and come back here only if you still get it after fixing the other errors.
To fix this error, set the Windows theme to Windows Classic. To do this, right
click on an empty area on your desktop, select Personalize in the pop up menu,
then click on Themes, then click on Modified Themes, and set the theme to
Windows Classic. Restart the bot.
If the bot still gives this error after changing the Windows theme, then you will
need to change the “Active Window Border” size. Right click on an empty area on

the desktop then choose Personalize in the pop up menu. In the dialog box that
shows up, click on the Window Color link towards the bottom middle part of the
dialog box. A dialog box titled “Window Color and Appearance” will pop up. The
“Item” list in this dialog will show “Desktop”. Click on the arrow next to “Desktop”
and choose “Active Window Border” in the drop down list. Set the size to 1.
Again click on the arrow and choose “Border Padding” from the drop down list.
Set the size to 0. Click on OK in the Window Color and Appearance dialog.

Error No 4: DPI Setting must be set to 96 dots per inch
Windows XP
To fix this error on a Windows XP machine, right click on an empty area on the
desktop then choose Properties in the pop up menu. Click on the Settings tab in
the Properties dialog. Then click on the Advanced button. Change the DPI setting
to 96 Bit in the General tab. Click on OK in the Advanced dialog and on Ok again
in the Properties dialog. Note that this change requires you to shut down and
restart your windows machine in order for it to take effect so you MUST restart
your machine after making this change.
Vista, W7, W8, W10
To fix this error, right click on an empty area on the desktop then choose
Personalize in the pop up menu. In the dialog box that shows up, click on the
Display link at the bottom left corner. You will then see a screen titled “Make it
easier to read what’s on your screen”. On this screen select the option titled
“Smaller – 100% (default)”. Then click on the Apply button. A dialog box will
come up with tONow” button. A detailed step by step process to change your DPI
setting on Windows7 machines, along with screenshots, is given at:
http://www.recipester.org/Recipe:Change_DPI_Size_in_Windows_7_25979243

Error No 5: Invalid caption height
Windows XP
On Windows XP this error could be due to an invalid DPI setting, invalid font size
setting, or because you have messed with the “Active Title Bar” size setting.
If the error is due to an invalid DPI setting, then you will also get Error No 4.
Fixing that error should fix this one as well. So fix that first.
If you still get this error, then the problem is likely caused by an invalid font size.
To fix the font size issue, right click on an empty area on the desktop then
choose Properties in the pop up menu. Click on the Appearance tab in the
Properties dialog. Set Font Size to Normal and click on Ok. Restart the bot.

If you still get this error, then it is likely due to a non-default “Active Title Bar”
setting. To fix that, right click on an empty area on the desktop then choose
Properties in the pop up menu. Click on the Appearance tab in the Properties
dialog and then on the Advanced button. The “Item:” list in the Advanced dialog
will show “Desktop”. Click on the arrow next to “Desktop” and choose “Active
Title Bar” in the drop down list. Set the size to 18 if you are using Windows
Classic theme and to 25 if you are using Windows XP. Click on Ok in the
Advanced dialog and then on Ok in the Display Properties dialog.

Vista, W7, W8, W10
This error could be due to Error No 3 (Style is not set to Classic) or because of
Error No 4 (DPI is not set to 96 bits). If so, you will also get one of the above
error messages. Fix those first according to the instructions for fixing those
errors.
If on re-starting the bot after fixing the above errors, you still get this error
message then you will need to change the “Active Title Bar” size setting. Right
click on an empty area on the desktop then choose Personalize in the pop up
menu. In the dialog box that shows up, click on the Window Color link towards
the bottom middle part of the dialog box. A dialog box titled “Window Color and
Appearance” will pop up. The “Item:” list in the Window Color and Appearance
dialog will show “Desktop”. Click on the arrow next to “Desktop” and choose
“Active Title Bar” in the drop down list. Set the size to 18. Click on Ok in the
Window Color and Appearance dialog.

Error No 6: Invalid color quality
Color quality must be set to 32 bit color. The bot automatically sets this for you so
you should never see this error. If for some reason the bot is unable to make the
change for you, you will need to do it manually. On Windows XP this can be done
as follows: Right click on an empty area on the desktop, then choose Properties
in the pop up menu. Click on the Settings tab in the Properties dialog and set
Color Quality to Highest (32 bits) and click on OK. (A similar path will exist on
later Windows systems.)

Display Settings Trouble-shooting.
If you are certain that all your poker room settings are adjusted correctly as per
the instructions above, and the bot is not giving you any error messages on
startup, but you are still having trouble with the bot reading the buttons, or are
getting invalid opponent count messages, or too many missed clicks reports, try
the following:
From Control Panel find Performance Information and Tools.
Under Tasks, click Adjust Visual Effects.
Make sure Let Windows choose what's best for my computer is set. Do NOT
set this to Adjust for best performance.
If all this fails, please Contact Us. We can solve most individual display settings
issue by email.

